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This manual details the installation and use of the addVANTAGE Pro
software product, which is used in conjunction with most of Adcon’s
telemetry devices. For information about the installation and use of
the telemetry devices, refer to the respective device’s manual.

Following are some of the features in this version:

Several new and changed icons have been added.
New colors and color schemes are available.
Unneeded icons and menus were removed.
Several user options have been added.

The map viewer has been greatly improved.

You can display a trend using virtual instruments and you have
additional options for displaying the trend.

Added a dialog you can use to mark values as Bad or remove
manual values in a time interval.

Added dialogs you can use to switch a digital tag node on or off.

The addVANTAGE Pro software and telemetry devices work together to
form the Adcon system, which can be defined as a system that allows
you to:

1.

Measure certain parameters over a predefined area
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2. Send those parameters over relatively large distances to a central
point

3. Process the parameters as needed for various applications such
as agriculture, meteorology, irrigation control, water
management, and environmental analysis

By parameters we mean a physical value that can be converted to an

electrical counterpart. For example, air temperature, relative humidity,

and leaf wetness have values that can be converted to an electrical

form by means of sensors. If a sensor exists for a certain physical

parameter, it is very likely that it can be adapted to Adcon’s system.
illustrates the components of the Adcon system.

Figure 1. The Adcon Telemetry System
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The electrically converted parameters are first stored in the memory
of a remote telemetry unit, or RTU. Adcon currently provides a large
array of RTUs employing different wireless technologies, from private
radio to GSM/GPRS based devices.

An RTU has its own intelligence in the form of a built-in
microcontroller, which periodically performs several tasks, for
example, interrogate the sensors, store the measured data, check the
radio channel, check the local battery status, and so forth. It is part of
a remote station, which consists of the RTU, its assembly parts, and
its sensors. The RTU is equipped with a radio module or a GSM
modem, which allows for real-time wireless communication with a
base station.

Reverse communication is also possible with the Adcon system. The
addVANTAGE Pro software can issue a command that will be sent via
the wireless network to the RTUs to control devices such as switches,
pumps, motors, and relays.
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The base station consists of a Telemetry Gateway (or receiver) and
your personal computer. The Gateway acts as a network controller—at
regular intervals (typically 15 minutes, but this can be changed) it
requests data via radio or modem from the RTUs in the network. The
receiver stores the incoming data in its memory, thus allowing the
receiver to supervise a large number of RTUs and keep their data for a
period of time without the need to download the data to the PC. The
number of controlled RTUs depends on the receiver type, and some
receiver models can handle over 1000 units

The period of time a receiver can store data is dependent on the
number of RTUs in the network and the type of receiver. The oldest
data is overwritten.

The addVANTAGE Pro software regularly downloads the data from the
receiver’s memory to the PC. The receiver’s internal battery allows it

to operate for 12 to 24 hours (depending on the number of RTUs to be
requested and the respective polling interval) in the event of a power
outage. After that, the receiver stops accumulating data, but it keeps
the data already retained—even without power—until you are able to
provide power to it.

The addVANTAGE Pro software, which is based on a client/server
architecture, collects data from one or several Adcon Telemetry
Gateways (receivers) and makes it available for viewing or for
specialized analysis.

The server is that part of the software where all the actual processing
takes place. It usually starts automatically when the computer is
started and runs in the background. The server is responsible for
downloading data from the Telemetry Gateway, storing data into the
database, starting and stopping extensions, and servicing clients as
they connect.

The addVANTAGE Pro server is based on a modular concept, meaning
its parts contribute to the whole but are also independent of it. The
server has a framework that runs various services and each service is
responsible for a function. For example:

- The Security service authenticates the users and checks their
privileges.

- The Directory service deals with all objects existing on the
system.

- The Data Acquisition service retrieves the remote data.

- The Extension service creates the proper environment for the
extensions to run.

. The Database service assures the connection to the database for
all other services.

Extensions are a very important concept of addVANTAGE Pro. They are
standalone modules dealing with raw data and processing it according
to certain rules. Extensions provide events and alarms; in some cases,
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extensions may provide output tags (which are also called virtual
sensors, but more on this later).

This modular approach provides a great degree of flexibility both to
users and programmers because it offers, among other things, an
open interface for third parties that want to program new extensions.

Starting with addVANTAGE Pro 5.0, the client software is based on a
standard web browser. Internet Explorer 8.0 and Mozilla Firefox 3.5
have been certified to be fully compatible with addVANTAGE Pro 6.x
and additional browsers could be supported in future releases.

WAP access is automatically enabled in addVANTAGE Pro 6.1 and it is
password protected. The information accessible via WAP is limited and
the users can access only the last value recorded for each tag.
However, you can disable password protection for WAP access on your
server.

To access the addVANTAGE Pro server via WAP, your users need to
enter (and store) a link similar to:
http://yourserver.domain.com:8080/wap?u=username&p=passwd

If the password protection feature is disabled, the link becomes
simply:
http://yourserver.domain.com:8080/wap

After the link is entered in the cell phone, the user simply accesses it
as a normal WAP link. The navigation is limited to the areas, RTUs,
and tags where the user has access rights (if password protection is
enabled).

This section explains standard terminology and usage for Adcon
software and manuals.

Although you will not see a software window that looks exactly like the
one shown in , we have included it to illustrate the various
items on a software window.

Most operations in addVANTAGE can be performed on a context basis.
That is, right-clicking an object displays a context menu from which
you select the desired operation. You can see an example of a context
menu in in Chapter 2.

This manual does not attempt to explain basic computer use.
Therefore, you should be familiar with basic computer terminology
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and the use of typical computer interfaces like the mouse and

keyboard.

LIST EOX

Figure 2. A Sample Software Window
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Certain conventions apply in this documentation.

Italics Indicate the text is variable and must be
substituted for something specific, as indicated in
the explanation. Italics can also be used to
emphasize words as words or letters as letters,
and for cross references to other books.

Bold Indicates special emphasis of the text.

fixed font Indicates characters you must type or system
messages, as well as default values and file
names.

Help » About Indicates menu selection. For example, select the

Help menu, then the About option. Also indicates
items on the graphical user interface.

Note Indicates information of interest. Notes appear
after the information they apply to.

CAUTION Indicates that you might get unexpected results if
you don’t follow the instructions. Cautions appear
before the information they apply to.

WARNING Indicates danger to yourself or damage to the
device if you don’t follow the instructions.
Warnings appear before the information they
apply to.

You’ll see the terms tag and sensor used throughout this manual. Tag
is a generic term for something that pertains to data, regardless of
whether it collects or controls that data. Tags can represent any of the
following:

- Physical sensors, such as those for temperature, leaf wetness, or
humidity.

. Actuators, such as switches, relays, or valves.

. Virtual sensors, which are the result of a computation, such as an
average, a sum, or an ETy (evapo-transpiration reading). Virtual
sensors are created with extensions. With some extensions, you
can use a virtual sensor in combination with other sensors to
create a new virtual sensor, which in itself is another tag.

Adcon’s Data Acquisition system contains hardware and software
parts. The hardware components are:

- A personal computer and/or a server machine
- The receiver or Telemetry Gateway (A840, A850, A440 modem)
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- The RTUs (also referred to as devices), for example addWAVE
A733, addWAVE A733GSM, addIT A723, and addNODE A740.

. Sensors and actuators

. Various supplementary parts (accessories such as antennas,
cables, and masts)

The software consists of:

- The addVANTAGE Pro 6.1 server

. Application-specific server extensions

- Utilities for configuration and maintenance
- A web browser



Since the initial introduction of addVANTAGE Pro 5 in 2006, you have
been able to access the client software through a standard Internet
browser such as Microsoft Internet Explorer or Mozilla Firefox. While
you still have the option to install addVANTAGE Pro on your own
machine, you can also work through an internet connection linking up
to your data provider’s addVANTAGE Pro 6.1 server, accessing all the
features through your web browser on that machine. All you will need
is a reasonably fast internet connection and a user name and
password to access your data.

For large installations, Adcon recommends that you install the server
on a separate computer. The server must have enough power and
memory to sustain the expected number of clients and RTUs, as well
as the number of extensions that will process the data.

You can consider several types of systems depending on your
application and the corresponding license type you acquired. For
example, if you have an application where you manage only one or
two remote stations (RTUs), you could install the server on the same
machine you are using for your day-to-day use. After installing
addVANTAGE Pro you need only point your browser to your local
computer (e.g., http://localhost:8080) and you can analyze your data.
You don’t even need access to the Internet for this type of setup.

At the other end of options, if you intend to offer addVANTAGE Pro
services to other users, running tens or hundreds of RTUs, you most
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likely will want to install the software on a powerful server with a good
connection to the Internet. A fixed IP address is mandatory in this
case.

In many cases you might not want to run a server at all and would
rather use the addVANTAGE Pro services offered by an addVANTAGE
Pro service provider as described in the previous paragraph. You need
only a web browser, an Internet connection, and an account (possibly
subscription-based) with your addVANTAGE provider.

Connecting to addVANTAGE Pro

You connect to addVANTAGE Pro by starting your browser and
entering the URL of your server, for example, http://
addvantage.adcon.at:8080. A web page similar to the one in
Figure 3 is displayed in your browser.

Figure 3. addVANTAGE Pro Login Window

addVANTAGE Pro 6.1

The next level of visuallzation

ADCON

TELEMETRY Smart Wireless Solutions

If you need browser information for logging in, you can click the
question mark (@) on the login window. A page with login help is
displayed.

You can also see the documentation before you log in, or get a
preview of the new features. Click the h or [EY New features
as needed.

Enter your User Name and Password and click the Login button to
access the system.

If the account data was correct, you are logged in to addVANTAGE Pro
and an Explorer window showing you the root node appears. For more

icon
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information about the Explorer, see . If you
want to disconnect from the server, click the Logout button.

The main elements of the software are:

- The Explorer

. The List

- The Trend viewer

. The Events viewer
- The Map viewer

- Administration tools
- Extensions

To start your addVANTAGE Pro session, follow the steps in

After you have logged in, the browser will display the opening page of
addVANTAGE Pro. This is called the Explorer because it allows you to
explore all the objects in an addVANTAGE Pro system.

Your browser window might be resized when you log in to
addVANTAGE Pro.

Use the Explorer to navigate through all the objects in your system:
areas, RTUs (devices), tags (sensors), extensions, and panels. All
such objects are generically called nodes. You can open more than one
Explorer at once, each showing different levels of the system tree. You
can also move certain node types from one area to another.

After opening an Explorer, expand the root node, which will probably
show only areas, RTUs, and tags. In order to familiarize you with the
new terms, shows most of the node types available in the
tree structure. You probably won’t have all of them in your tree, but
you will be able to generate them later.
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The root node contains all the objects in a system. You can also think
of it as the container for the database on a server.

Figure 4. Expansion of Root Node in Explorer
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An area is an object that defines a certain place that you have
associated with a specific property. It can be a field, a city, a section in

a plant, a country, or any other physical place. You can also have
areas within areas, or subareas.

Tacs

RTUs

An RTU is placed in an area. You can have as many RTUs in an area as
you want—limited only by the type of license you own and the remote
server or Telemetry Gateway you are downloading data from. All the
RTUs in a certain area have the common property that they belong to
that area.

The RTUs have tags, which can be sensors or actuators. A tag can also
result out of the processing of other tags by an extension.

Crops act as containers for extensions (calculations or disease models)
that are specific to one crop field in one year. Crop nodes have all the
required phenological phases, irrigations, and treatments.

Calculation extensions are types of embedded software that process
input tags following certain rules and output events or other tags
(virtual tags). This type of extension can also control output tags
(actuators), effectively implementing remote control functions.
Calculation extensions apply to an area rather than a crop.
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Disease models are types of embedded software that track the
progress of common diseases that are specific to a crop. They are
always the children of a crop node.

Panels are the result of saving a view. For example, if you create a
Trend and want to refer to it later (see ), you can save it as a
panel.

As the “main window” in addVANTAGE Pro, the Explorer offers many
features. In addition to the usual expand/collapse of branches by
clicking the plus (+) or minus (-) sign, you can rename a node just by
clicking the name twice.

You can also right-click a node and see a variety of options on the
context menu, depending on the node type and the permissions your
user ID has. , for example, shows the context menu for a tag
for someone with admin permissions.

Figure 5. Right-clicking a Tag in Explorer
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These features are discussed below and in other sections of this book.

Renarme Node
Follow these steps to rename a node:

1. Click once to highlight the node you want to rename (left side of

2. Click the node again to turn the name into an edit box (right side
of ).
3. Type the new name.



4. Press Enter.
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Figure 6. Renaming Nodes
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Create nodes such as areas, windows, extensions, crops, and tags.

Show Events

Open a list panel showing the events on the node and all of its

subnodes.

Manual Event

When you right-click a node in the Explorer, you’ll see a Manual event
choice. Select it to display a dialog similar to the one shown in

Figure 7.

Source:

Begin Date:
Duration:

Severty:

Comments:

0K

Creating a Manual Event

Temperature
Jan 19, 2010 9:52 PM

d h m

Event -

| Cancel |

1. In the Begin Date field, enter or select the date you want to be
associated with the event.

2. Leave the Duration fields blank if this is an active event.
Otherwise, enter a zero for days, hours, or minutes to indicate a
simple, one-time event.
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3. Select a Severity level from the dropdown. Your selection
determines whether the manual event is shown as an Alarm,
Event, or entry in the Service log.

4. Enter the Comments that will be displayed in the Events viewer.
5. Click OK to close the dialog.

Show Action Settings

Opens a dialog that lists the Action settings of the selected node and
its children. With this dialog, you know at a glance which Actions have
been executed, such as when the threshold was reached.

Explore from Here
Open a new Explorer with this node as the root.

Search from Here
Search only this part of the Explorer.

Connect To

Connect the node to the server by selecting the server and choosing
the device from the dialog that appears.

Reload Data
Retrieve data from the server.

You need another addVANTAGE Pro server, an A840 (firmware release
3.8.0 or higher) or an A850 Telemetry Gateway, to be able to retrieve
remote data.

Change Values Manually

You might find that the values on one sensor have data errors or need
to be marked as bad. You can use this feature to change the values
manually. Follow these steps:

1. Right-click the tag whose values you want to replace.
2. Select Change values manually to display the dialog shown in

Figure 8. Change Values Manually Window

Target: Relative Humidity

iCopy values from another tag; ~ Source:

Start time:  January 12, 2011 - 0000 2

!
End time:  January 12, 2011 L =] 23:59 =5

OK Cancel
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Target shows which value you selected to change.

3. Click the down arrow next to Source to choose what you want to
do:
- Copy values from another tag
Select this when you know another tag has the correct
values and you want to copy them to the current tag.
Continue with step 4.
. Mark values as BAD
Select this to mark a range of values as incorrect. Skip to
step 7.
. Remove manual values
Select this to replace manual values with automatic values
for a range. Skip to step 7.
4. Click the Source field to display a Tag Chooser dialog similar to
the one shown in .
Figure 9. Tag Chooser Dialog
= lL AddVANTAGE Pro 6 ~ | & Relative Humidity
= ._a condor
l_a Adeon Weather Test RTU E
L adcon weather Test RTU
+ é Apple 2010
Grapes 2010
Ela Acknowladgad Alarm
addTimer
" Alarm
Dew point -
ok | cancal |
5. Click the appropriate station in the left pane, then select the tag
with values you want to copy in the right pane.
6. Click OK to return to the Change Values Manually dialog.
7. Enter the Start time and End time for the values to copy, mark as
bad, or remove.
8. Click OK.
If you copied values from another tag, you’ll see that where the
values for both sensors are the same, the old are overwritten by
the new.
View Data

Open a Trend panel to see data from the node’s children.

Show on Map
View the location of the selected RTU on a map.

Properties
View and edit node-specific information.
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The menubar and toolbar in the Explorer ( ) provide different
ways to access the features of addVANTAGE Pro 6.1.

Figure 10. The Menu Bar and the Toolbar

nols Atindow | Help | Logout DELETE

Menubar

Tools: accesses addVANTAGE Pro 6.1 user options and other
administrativetools.

Window: refreshes the current window and allows you to select
an addVANTAGE Pro 6.1 window when multiple windows are open
Help: displays the documention and information about the
software.

Logout: exits the addVANTAGE Pro 6.1 software.

Toolbar

New Window: creates a new Events viewer, Explorer, List, or
Trend.

Save: saves the settings of the window or panel you have the
focus on.

Save As: enables you to save the current window or panel with a
different name.

Search Type: provides a quick search option to select an object
from the popup and then type search criteria in the text field.

Search: displays the advanced search dialog with more specific
options.

Delete: deletes objects you have selected in the Explorer.



The robust Properties and Tools features in addVANTAGE Pro are the
building blocks of the system. Properties let you tinker with node
settings such as whether a node is connected to the server and what
to do when a threshold is reached. The tools options affect system-
wide settings such as data acquisition and e-mail.

The tabs you see on the Properties dialog depend on the node type
and, in some cases, your user role.

When you right-click a node in Explorer and select Properties, you
have the option to view and edit various features related to the node.
The dialog that appears ( ) has three default tabs—General,
Action, and Security—but might have additional tabs, depending on
the node type and your user role.

The General tab displays certain information about the node, such as
its location and name. The Action tab enables you to set events and
actions specific to the node itself. The Security tab shows the node’s
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owner and the permissions various groups have in relation to the
node.

Figure 11. General Tab of Node Properties Dialog
General | Action | Security |

.

| s Addvantage Pro 6

Location: faddvantage Pro 6

Class: AREA
Subclass:
Node ID: 1
Alarms: 0 total, 0 acknowledged.
Events: 0 total, 0 acknowledged.
Service logs: 0 total, 0 acknowledged.
Aftnbutes...
0K | Cancel | Apply |

With the Action tab, you can specify the action that a certain event will
cause. The example below illustrates the sequence that occurs when
an extension’s threshold event is “Treatment recommended” and
action is “E-mail.”

E-mail
xtension Input Ta ven S
E put Tag Event Servi
: | I ]
_y Register on tag | _L :
I
or I
_) _Data changad ' Il
Extension| Fm———— |
.algmithﬂja |
Treatment recommended Action E-mailﬂ E-mail sent

The extension registers itself as listener on the input tag (e.g. the
Temp sensor) as soon as you set the Temp sensor as an input tag of
the extension. A possible event of this extension is the "Treatment
recommended" event. This means when you open the Action tab of
this extension, the table shows the "Treatment recommended" event.
For this event, you might choose to send an E-mail. As soon as this
event is issued, the mail is sent. In any case, an issued event is
always written to the node's event list.



CHAPTER 3

Node Properties

shows the Action tab of the Node Properties dialog.

Figure 12. Action Tab of Node Properties Dialog

General | DACQ Info | Action I Thresholds | Security |
Event | Action | Max. age of even* |

Threshold reached E-mall 1d

Threshold reached Landline call (SIP/VoIP)  1d

Threshold reached Switch On/Off 1d
+
=]
-

OK | Cancel | Apply I

1. Click the Add icon to display the dialog shown in
Figure 13. Adding an Action

MNode: Temperature
Event: Manual event -
Action: E-mail -
Max. age of event: d h m
Recipients:

OK | Cancel |

2. Select an Event from the list. The choices in the Event list depend
on the node type. For a tag, the choices might include problems
with the data or a threshold being reached. Manual event is a
choice for every node type.

3. Select an Action from the list.

The following actions are available:

. Landline call (SIP/VolP) uses the Session Initiation Protocol
(SIP) to make a landline call through the Voice over Internet
Protocol (VolIP).

When you select this action, you must enter the appropriate
Phone numbers and, optionally, select the Soundfile you
want to be played.

. E-mail sends an email to the Recipients you specify in the
field below. In specifying recipients, you can enter full e-mail
addresses in the format name@address.extension. For
recipients who are also system users, you can enter a
shortcut in the format user{name}, such as user{root}. For
multiple recipients, the order does not matter but you must
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separate each with a semicolon:
user{dimi};m.weller@adcon.com;user{root}

Note: In order to successfully send e-mails from addVANTAGE Pro, the
e-mail service must be properly configured.

. Switch On switches on an output port of an RTU.

- Switch On/Off switches on an output port of an RTU and
instructs it to switch it off automatically after a predefined
time elapses.

. Switch Off switches off an output port of an RTU.

If you defined the rule to issue a command (Switch On,
Switch Off or Switch On/0Off), you must enter the Node ID of
the tag to be acted upon. In the case of Switch On/Off, you
must) also specify how long the switch should be on (Open
time
4. Enter the day (d), hour (h), and minute (m) of the Max. age of
event. In other words, if you enter 6 hours and 30 minutes, the
action will not occur for the selected event if it happened more
than six and a half hours ago.

This field is helpful because you would likely find an event that

happened two years ago uninteresting and you certainly wouldn’t

want a SIP call made because of it.
5. Click OK to close the Add Action dialog.

6. When you’'re finished with the Properties dialog, click OK to close
it.

The next time the event you specified occurs in the node, the action

you specified will happen.

You can Edit or Remove only those actions you created.

Use the Security tab ( ) to set permissions for the node.

All of these settings show default values for the node. Our example of
a tag’s security settings shows that the owner is dimi and the tag
belongs to the admin group. You will rarely need to change these
settings, but you might want to assign different Privileges. Whether
you can assign different privileges is determined by your account
permissions.

Read and Write determine whether the node can be viewed (read) or
edited (write). Therefore, you can use this dialog to determine the
permissions the Owner of the node, the Group the node belongs to,
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and Everyone else has. You can also select None for any of the fields
to prevent anyone from viewing or editing the node.

Figure 14. Security Tab of Node Properties Dialog

General | Action | Security |

Ownership
Oamar:  dimi -
Group:  admin -
Privileges
Cramar: Fead & Write =
Group: Read Only -
Everyone: MNone -
Children Nodes

New children nodes will have  Default privileges from user =

Availability

Accessible from outside addVANTAGE Pro

Apply to all child nodes |

QK I Caneel | Apply J

For Children Nodes, you select whether to have child notes get the
same privileges as the user or the privileges of the node.

also shows the Availability section. If you select the
checkbox in this section, users who are not logged in will still be able
to see the node. In the case of a trend, selecting the checkbox makes
it publicly available.

If you want the security permissions to apply to all the nodes that the
current node is the parent of, click the Apply to all child nodes button.

Following is a discussion of the tab options for specific node types.
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shows you the Properties dialog for a tag. The difference
between RTU and tag properties is that you can set thresholds for a
tag. A discussion of the Thresholds tab begins on

Figure 15. General Tab of Tag Properties Dialog

General | DACQ Info | Action | Thresholds | Security |
a Battery Voltage
=T fAaddvantage Pro 6/Dimi Area/Adcon Weather Test RTU/adcon Weather
. Test RTU/Battery Voltage
Class: TAG
Subclass: BATT
Mode ID: 34
Alarms: 1 total, 0 acknowledged.
Events: 5 total, 0 acknowledged.
Service logs: 0 total, 0 acknowledged.
Template: ABS0_AMALOG_TAG
E:ﬂneenng 3500 (El. voltage (volt)), 1 digit(s).
Number of
values: 45498
First value: Nov 26, 2008 2:40:01 PM: 7.2V
Last value: Oct 8, 2009 2:30:00 PM: 7.1V
Last config .00
update: Oct 9, 2009 12:00:00 AM | Update config now!
Aftnbutes...
OK | Cancel I Apply ]

Review the General tab for information about the tag, such as its class
and subclass, node ID, number of alarms and events, engineering unit
used, and so forth.

Updating the addVANTAGE Pro Configuration

The tab also shows you the last time the software configuration
database entries were updated, which will usually be midnight of the
current day, unless it’s set to update at another time. However, if you
don’t use automatic configuration—or if you just want to update the
configuration now—click the Update config now! button. The system
retrieves the current configuration from the server and updates the
local one. If any special conditions are reached, an event could be
issued (for example, if you specified an action based on an event such
as the engineering units being changed, the event would be
registered.)
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Viewing Node Attributes
The General tab has an Attributes button. Click it to display the dialog
shown in
Figure 16. The Attributes Dialog
Attributes
Name Type Value
EUID INTEGER 3500
acquisitionMode INTEGER
acquisitionschedule STRING
manufacturer STRING Adcon Telemetry GmbH
maxValue DOUBLE 20.0
minyalue DOUBLE 0.0
sdiAddress STRING
sdilndex INTEGER
sdilnfo STRING
sdiMethod STRING
type STRING
version STRING

This dialog shows technical information about the tag’s attributes.

As shows, use this tab to view information about the source

and connection status of the tag.

Figure 17. DACQ Info Tab of Tag Properties Dialog

General | DACQ Info | Action | Thresholds | Security |

Data source: condor
Remote source ID: 22340

Status: CONNECTED

If you're viewing an RTU’s DACQ Info tab, you'll also see a Disconnect!
button. You cannot disconnect individual tags, but you can disconnect
the RTU. Once an RTU is disconnected on the DACQ Info tab, you will
need to right-click the RTU in the Explorer and select Connect
To>hostname. Then select the device in the dialog that appears.

When a tag is acquiring data, the icon for the tag and for the RTU will
display in the Explorer with a tiny moving arrow.
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Use the Thresholds tab ( ) to set conditions that will trigger
an alarm, event or service log entry when a threshold has been
reached.

Figure 18. Thresholds Tab of Tag Properties Dialog

General DACQ Info | Action | Thresholds | Security |

Conditions
Create "Threshald reached” event when:
ANY condiion was met
Condition Valuel Value2 | Unit | .
---No entries--- ] =
=
Event
Severity: Event -
Show duration: J
Remark: Checking voltage
0K | Cancel | Apply |

One of the actions you can set on the Action tab is for the Threshold
reached event. Use the Thresholds tab to create the threshold that
causes the action to occur, as detailed in the following steps:

1. Select whether to Create “Threshold reached” event when” one of
these choices is true:

- ALL conditions were met
- ANY condition was met
2. Add one or more conditions:
a. In the Conditions pane, click Add.
The dialog shown in is displayed.

Figure 19. Adding a Threshold Condition

Condition: |

Valuel:

0K J Cancel J

b. Click the Condition dropdown to select the threshold’s
condition. Following are the choices in this dropdown:

= is greater than

= is greater or equal to
e isequal to

« isless or equal to
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e isless than
* is between (incl)
The values are inclusive.
* is between (excl)
The values are exclusive.
* is between (incl - excl)
The values include the first but exclude the last.
* is between (excl - incl)
The values exclude the first but include the last.
c. In the Valuel field, enter the condition’s value.

d. If you used any of the “between” conditions, enter the other
value in the Value2 field that appears. The following table
describes how values are used with these conditions.

. Sample | Sample Condition
Condition Value 1 | Value 2 Applies to
is between (incl) 2.0 5.0 2.0, 3.0,
4.0, 5.0
is between (excl) 2.0 5.0 3.0, 4.0
is between 2.0 5.0 2.0, 3.0,
(incl - excl) 4.0
is between 2.0 5.0 3.0, 4.0,
(excl - incl) 5.0

e. Click OK to close this dialog and continue with adding a
threshold.

3. In the Event pane, click the listbox to choose whether this
threshold will result in an Alarm, Event, or entry in the Service
Log.

4. To show how long the event occurred, click the Show duration
checkbox.

5. Add a Remark to be displayed with the alarm, event, or service
log entry. (optional)

If you right-click a panel in the Explorer and select Properties from the
context menu, the dialog shows only the three default tabs. To set up
Lists, Trends, and Events, see .
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If you right-click an extension or a crop in the Explorer and select
Properties from the context menu, the dialog shows the default tabs
illustrated in

Figure 20. Default Tabs for Crop and Extension

General | Crop | Treatments | [rrigation | Action | Security
Grapes 2009
General | Extension | Advanced settings | Inputs | Action | Security

[#)]  conditons

To set up Extensions and Crops, see

Use the Tools menu for administrative tasks such as setting users and
groups, administering data sources, administering chemicals (for Plant
Protection extensions), and so on. The menu options you see depend
on your role, but following is a sample of the options:

User options

Server settings

User management

Data Acquisition service configuration
Force data acquisition

Chemicals database administration (only if at least one Plant
Protection extension is installed)
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To change options in your addVANTAGE Pro user profile, select
Tools » User options in the Explorer window. The dialog shown in
appears.

Figure 21. User Options Dialog, My Settings Tab

My Settings | Panels | Explorer | Craps | Extensions | Engineering Units | Security |

Language: English -
User: dimi
Full Mame:

Description:
Phone number:

E-tail address:

Ok | Camcel J Apply |

Use the My Settings tab to view or change various settings:
- Select the Language dropdown to choose the language used by
addVANTAGE Pro during your sessions.

- Enter or update your Full Name, Description, Phone number, or
E-Mail address.

Use the Panels tab ( ) to view or change default options for
trends, events, and all panels. You can change all of these options
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separately when you work with panels, as described in

Figure 22. User Options Dialog, Panels Tab

My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

—Options for all panels
Automatically save panals on close
¥ Show seconds in panels

Re-open last openad panels when log in
Trends options

Default type for trend when creating a new trend with View Data menu:
Graphic view -

| l:l|' | Default background color for graphic

| l:l" | Default background color for axis
I_I' * | Default background color for legend
." Font color of legend

." Default color of time axis

—Events option

When using "Show events” explorer sub menu, create an event with following options:
/1 show alarms

Show events

(o3 | Cancel | Apply |

Options for All Panels

- Automatically save panels by selecting the Automatically save
panels on close checkbox. If you activate this option and close a
panel you made changes to, you are not asked if you want to
save the panel—the panel will be saved by default.

- Select whether to see seconds when displaying time in a panel by
clicking Show seconds in panels.

. If you prefer to always open addVANTAGE Pro with the panels you

previously used open, select Re-open last opened panels when
log in.

Options for Trends
These options serve two purposes:

1. At the top of the section, select the default view to use for a trend
you create when you select View Data from the context menu:
graphic, table, or instrument.

2.  From the boxes that follow, define color defaults for the Graphic
view of new trends. You cannot use this dialog to change the
colors in open or existing trend panels.
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Options for Events

Use these checkboxes to determine whether a new Events Viewer
should Show alarms, Show events, or show both.

Use the Explorer tab ( ) to display the internal ID of each
object in the Explorer. You probably won’t need to activate Show Node
IDs under normal use, but it can be valuable when you are debugging
the system or you need technical support.

Figure 23. User Options Dialog, Explorer Tab

My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

Show Mode |Ds
QK | Cancel I Apply J
Use the Crops tab ( ) to view or change the Crop default start

date, that is, the date to start collecting data about the crops.
Figure 24. User Options Dialog, Crops Tab
Ry Settings | Panels | Explorer | Crops | Extensions | Engineering Units | SECurity |

Crops default start date: 1 = January -
¥ Show crop in the Explorer context menu

Visibla crops in Explorer menu:

+| Apple =
Celery

| Grapes E
Hop

Lettuce

Onian

Pear

[t minfe

Check all | Uncheck All

4| Automatically install crop extensions when crop is created.

Ok | Cancel I Bpply |

This dialog shows which crops will be visible to the user in the Explorer
context menu. If a crop is not selected in this list, the user cannot add
it to a node.
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You also see an Automatically install crop extensions when the crop is
created checkbox. The addVANTAGE Pro software can automatically
include disease models and calculation extensions (collectively called
crop extensions) usually associated with the crop. If you select this
checkbox, those defaults are automatically added with the crop when
it is added to a node. If this checkbox is not selected, only the crop
itself is added to the node. The user can select the crop extensions
separately—but only the extensions that are associated with the crop.

If a specific crop extension has been made invisible on the Extensions
tab (as described next), the extension will not appear in any list of
disease models or calculation extensions that can be added to the
crop.

Your ability to edit this dialog depends on your role.

Use the Extensions tab ( ) to select whether to Show
advanced settings in extensions. If selected, the Advanced settings
tab displays in an extension’s Properties dialog.

Figure 25. User Options Dialog, Extensions Tab
My Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

¥ Show advanced settings in axtensions
Wisible extensions (uncheck to make invisible):
4 addTimer =
4| Basic arithmetics
Bunch Rot [Broome madel]
CEMEX-Export
Chilly Heat Hours
Conditions o
Degrae Days
Dew paint
Doy dildews
Dowmy ddlldew [Kast PeroDiag model)
DEv
ETe
ETo
Fire blight (Cougarblight model)
Fire blight [Maryblyt model)
Flow To Volume
Hops Dowy sildew
Hops Powdery sdildew
Late Blight [Ullrich-Schroedter model) -

Check All uncheck all |

e B B e B et e B e B e B B ] I B I e AT I e T S

oK | Cancal | Apphy |

You can also make the various calculation extensions and disease
models visible on the context menu.

Your ability to edit this dialog depends on your role.
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Use the Engineering Units tab ( ) to change the engineering
units used to express the tags.

Figure 26. User Options Dialog, Engineering Units Tab
iy Settings | Panels | Explorer | Crops | Extensions | Engineering Units | Security |

System: Imperial -
Original Engineering Unit:
Area |are) -

Area [hectare)

#rea [square centimeter)
Area (square decimeter)
Brea [square foot)

Area [square inch)

Displayed Engineering Unit:

Area [hectare)
Area [square centimeter]
Area [square decimeter]
Area [square foot)

@ Area [square inch)

oK | Cancal | Apply |

Use the System dropdown to choose how engineering units will be
displayed to you. Metric and Imperial provide a set of default units
that are either metric or American. For example, shows that
the original engineering unit for Area (square centimeter) in the Metric
system will be displayed as Area (square centimeter). If you select the
Imperial system, the displayed unit changes to Area (square inch).

You can also make specific selections for one or more of the original
engineering units. To use a different displayed unit, select the Custom,
system and click the radio button indicating the unit you want to be
displayed, such as Area (square foot).

To change the engineering unit for a specific tag in addVANTAGE Pro,
do the following:

1. Find the engineering unit you want to change in the upper pane
of the dialog and select it.

2. Valid alternatives are displayed in the lower pane. Select the one
you want.

3. Click Apply.
4. To change other engineering units, repeat steps 1 through 3.
5.  When you are finished, click OK to close the dialog.

Your ability to edit this dialog depends on your role.
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Use the Security tab ( ) to view or change security settings
associated with your user profile.

Figure 27. User Options Dialog, Security Tab

My Settings | Panels | Explorer | Crops | Extensions | Engineering Lnits | Security |

User: dimi

Mew Password: [T

Confirm Password: ssse

Cwiner: Fead & White

Group: Fead Only -

Everyone: MNaone -

Session time out: &0 min: 5 minutes; max: 60 minutes
Heed the password for WaP p

ACCESS

QK | Cancel ] Bpply J

You can change your password and account privileges, as well as the
duration of your session timeout and whether you must use your
password for WAP access to addVANTAGE Pro.

Some users will see only the User’s name and the password fields.
Your ability to edit this dialog depends on your role.

Adcon does not supply lists of chemicals because the rules for their
use differ between locations. For more details about this service,
please consult the addVANTAGE Pro 6.1 Extensions and Crops manual.
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Lists, Trend Viewers, and Event Viewers are panels that offer different
ways to view data in addVANTAGE Pro 6.1.

Use the List to display a group of addVANTAGE Pro objects in a
different way. The List is similar to an Explorer view, with the
difference that the objects in a list are not expandable. Use a List
when you need to work on a group of objects with similar properties,
for example, configure extensions or synchronize tag settings.

You can create a List by clicking the New Window icon and selecting
List. Use the Add Nodes button on the List’s toolbar ( ) to add
objects to the list. You can also remove objects that you no longer
need by using the Remove Nodes button on the toolbar.

Figure 28. List Toolbar

REMOVE
SAVE MoDeEs

SAVE AS ADD NODES

Removing an object from the list does not permanently delete it from
the database. You will continue to see the object in an Explorer panel.
To permanently remove an object, right-click it and select Delete.
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When you add objects to a list from the List’s toolbar, the Choose
Nodes dialog opens, as show in

Figure 29. Choosing Objects to Add to a List

_ll addVANTAGE Pro & . ? APRO Hosting 01 Adcon Klosterneuburg
' condor APRO Hosting 01 Gateway
li Dimi =\l Condor Weather Test RTU 3
+ APRO Hosting 01 Adcon Klosterneuburg q Apple 2011 [
+ APRO Hosting 01 Gabteway Wh. Celery 2011
" Condor Weather Test RTU % Grapes 2011
+ @, Apple 2011 Hop 2011
v I celery 2014 M Lettuce 2011
v " Grapes 2011 o Onion 2011
+ Hop 2011 }, Pear 2011
+ M Lettuce 2011 {# Pistachio 2011
+ 4 onion 2011 . i Patato 2011
0K | Cancel |

Choose a node on the left side of the dialog. The objects you can
select are displayed on the right side of the dialog.

If you’re using Internet Explorer, you can also add objects to the List
by dragging and dropping them from an Explorer into an open List. If
you're using Firefox, you can drag and drop an object onto the List’s

icon in an Explorer.

You can also create a list as a result of a search operation. Suppose
you want to search for all areas in the system having the string
“Adcon” in their name. Follow these steps to search for those areas
and populate the List:

1. In an Explorer, click the Search icon (the magnifying glass icon on
the right side of the text box in the Explorer toolbar) to open the
advanced search dialog (

2. Node name is displayed by default, Wlth the default property of
contains. Enter Adcon in the text field.

3. Click the Add criteria dropdown, then select Class.

Another line of search parameters is displayed in the Search
dialog.

4. Keep the default property of is, but from the next dropdown,
select area.
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5. Click the OK button.
Figure 30. The Search Dialog

Search In: /addvantage Pro 6

Search for nodes whose:

Node Name contains ~  Adcon x

and Class is - Area - x

Add criteria.. -

ok | cancel |

A List appears (Figure 31), containing all the objects fulfilling the
selected criteria. After performing the required operations on the
nodes in the list, you can save the list as a panel or discard it by
closing it.

Figure 31. A List Viewer

ADC®N addVANTAGE Pro 6.1

TELEMETRY

Tools | Window ! Help | Logout

i Name Location
_i:f Adcon Events faddVANTAGE Pro &/ Dimis
'] Adcon Trands £ addVANTAGE Pro 64 Dimis
Adcan Waather Tast RTU FadaVANTAGE Pro &/ MH_test_aUSTRIAS
Adeon Weather Tast RTU A addVANTAGE Pro &/ condorf
APRO Hosting 01 Adcon Klosterneuburg  faddvANTAGE Pro &/ Dimi/

A quick search option is also available:

1. Click the magnifying glass icon on the left side of the text box in
the Explorer toolbar.

2. Select the search criteria (Name, Class, Subclass, or ID). Add and
remove the search criteria as needed.

The search starts from the node you selected in the Explorer.

3. Type the string you are searching for and confirm it by pressing
the Enter key.

A list with the criteria you entered is displayed.

41
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You can also right-click a node in the Explorer and select Search from
here. The Search dialog shown in is displayed, but the
Search in line shows the node where you started the search. Complete
the Search dialog as described previously.

A list is a collection of nodes you want to treat as one object. For this
reason, you should view properties only on the items in the list.

Use the Trend viewer to see a plot of tag values stored in the
database. To open a Trend viewer, click New Window and select Trend.
The trend toolbar is shown in

Figure 32. Trend Viewer’s Toolbar

Januany 17, 2011

TIIY] 1 1Y, 1T L

9 10 11 12 13 44 15 16 17 18

Prior to explaining the ways to display data in a Trend viewer, please
make yourself familiar with the tool bar and its elements, which you
will frequently use in your daily work with addVANTAGE Pro 6.1.

Button 1 Save Saves the current panel. If this panel has not
been saved before, clicking this button opens a
dialog you use save it.

Button 2 Save As Opens a dialog you use to save the current
panel with different name. If the current panel
has not been saved before, this button
functions the same as the Save button.

Button 3 Print Prints the Trend on the default printer.

Button 4 Properties Opens the Trend Options dialog, where you set
the options for each object in the Trend, or
add/remove objects from the Trend.

Button 5 Go to Begin  Sets the starting date of the trend to the
beginning date of your database.

Button 6 Go 1/7/30  Moves the starting date of the trend 1, 7, or 30
Days back days back.

Button 7 Go back X Goes back the specified period of time, where
X is the span shown in 13.
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Button 9

Button 10

Button 11

List 12

Button 13

Button 14

Button 15

Button 16

Button 17

Button 18

Date
Chooser

Go forward X

Go 1/7/30
Days
forward

Go to End

Span
Chooser

Show Values
at Cursor

Always jump
to last
available
data

Graphical
view

Table view

Virtual
instruments

Link to
another
window
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Shows the start date of the Trend viewer.
Clicking the downwards arrow to the right of
the Date Chooser opens a calendar you use to
select a specific start date.

Goes forward the specified period of time,
where X is the span shown in 13.

Moves the starting date of the trend 1, 7, or 30
days forwards.

Sets the end date of your database at the end
of the currently selected span. If you have, for
example, selected to view a 7-day span, and
you click Go to End, the trend viewer will
show you the data of the last 7 days of your
database.

Displays the time span being used in the trend.
Click the downwards arrow to the right of the
Span Chooser to open a dropdown with
predefined time spans to choose from.

You'll also see a Custom duration. Select this
to display the Trend Options dialog, where
you'll select the Display tab and choose the
duration you want.

Displays the values of each tag in a little flag
next to the cursor. This allows a faster
understanding than looking at the legend.

If you unselect this button, you can click and
drag to see several statistical values for the
selected area.

Sets the Trend view to always open showing
the last available date. (Replaces having to
open a Trend view and click Go to End.)

Displays the Trend’s values on a graph.

Displays the Trend’s values in a table. Table
View also enables you to export data with a
mouse-click.

Displays the Trend’s values as they might
appear on an instrument panel.

Opens a panel chooser to let you link the panel
you are working with to another panel (see

).
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Viewing Trends with Drag-and-Drop

LEGEMD

L B = T RS SR W Cecember 27, 2010

—

-

(1l Temperature

Expand the tree in an Explorer until you reach the desired tag, then
drag and drop it into an open Trend viewer. After a short delay, the
tag’s plot is displayed in the Trend viewer. Figure 33 shows a Trend
viewer displaying data for several tags. Notice that each tag in the
graph displays in the color designated for it in the Legend that is to the
left of the graph. You’ll also see that the Y axis color is linked to the
tag color, but you can change that in the trend’s properties (see

page 47).
Figure 33. A Trend Viewer
——TOOLBAR
MENLUBAR
ADC®N | addVANTAGE Pro 6.1
TELEMETRY The next level of visualization

Tools W imolf oo Halp Logout

71 [l Eattary voltage T
114 ¥
D 27, 2010 12:00:00 AM) ‘
7| [l Leat wemess
ou
(D 27, 2010 12:00:00 A4

71 [l Precipitation 100
0.000 inch
D 27, 2010 12:00:00 AM)

71 [l Relative Humidity
BE.1 % RH
(D 27, 2010 12:00:00 &)

251 'F
(Deec 27, 2010 12:00:00 AM)

[ 1} A

00 AM W00 am 12:00 PM TOOFM N ENOFM

/ Xeaxis

Y-AXIS PLOT

You can plot tags coming from different RTUs on one Trend viewer. If
you have tags from different RTUs with the same name, you can easily
identify them by placing the cursor in the legend for the respective
tag. After a short delay a tool tip pops up, displaying the tag’s full
path.

Note: Currently the drag and drop method works only if you are using
Microsoft Internet Explorer. In Firefox you can still drag and drop tags,
but only onto a Trend viewer icon within the same Explorer.
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addVANTAGE Pro 6.1 provides another way of creating a trend view,
right from your Explorer. This is a great way to quickly create a trend
panel for temporarily looking at data.

1.

In the Explorer select the tags you want to see in your Trend
(left-click the desired tags while holding down the Shift or the Ctrl
key).

Right-click the selected tags and select View Data from the
context menu as shown in .

Figure 34. View Data from Explorer

w mom o I
[, addVANTAGE Pro &
= ﬁ condor

.L Adcon Weather Test RTU

= -_; Adcon Waather Tast ARTU

S attary  Create Mew Nod 3
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Y Durmry | ES] Show events
Incommin (&) sanusl Event...
Leaf e

e]
¢
B outgoin
=

Show action Settings

Power O

.| ¥ Delets
- Precipit,
Precipit,
- Explore from here
- Precipit l’l
Precipit) %] Search from here...
Pyranom
B2 Radio Er  Connect
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& FRelative
Change values manuall
.,l] Soil Ten g i

Bl solar ce 2 View data
L Temper.
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If you want to keep this Trend, you need to save it by clicking on the
Save icon. Else if you close the panel you will be asked if you want to
save it, unless you have selected Tools » User options » Panels

» Automatically save panels on close. In this case the new panel will
be discarded unless you save it manually.

If you can’t use drag and drop, follow these steps to display data in a
Trend viewer:

1.

2.

In an active Trend viewer, click Properties to display the Trend
Options dialog shown in

Click Add to display the Tag Chooser dialog listing the available
tags.

Expand the tree until you find the tags you need to display (you
can select more than one tag by using the shift and control keys).
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4. Click OK when you are finished. The selected tags are now
displayed in the Tags list, in the order you chose them.

If you need to add other tags in the Trend viewer, including tags from
different areas/RTUs, repeat Step 2 through Step 4. To delete a tag,
select it and click the Remove button. By using the arrow buttons, you
can change the order of the tags in the list. When the Trend Options
dialog lists all the tags you want to display, click the OK button. The
Trend viewer displays the tags and their data in a graphic form.

Figure 35. Selecting, Adding, and Removing Tags
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If no plots are displayed, check the date and use the arrows and the
calendar in the Trend viewer to move to a date and time where you
have data.

You can also use the extensive features available in the Trend Options
dialog to customize the way your graph looks by viewing and changing
the options on the Y-axis, Plots, Thresholds, and Display tabs.

Following is an explanation of the options on the Y-axis tab shown in
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Use sensor color as Axis color. The Y-Axis and sensor colors are

assigned by addVANTAGE Pro and are identical by default. If you

leave this checkbox unselected, you can use the color chooser

you see to change the y-axis color, but the corresponding color of

the tag on the graph will not change. If you select this checkbox,

the color of the y-axis will be the same as the sensor color (as

displayed on the Plot tab).

Scale

- High /Low : The scale refers to the tag’s value range—in
other words, the maximum or minimum value that is
expected. If the tag can deliver data only in the range of
-60°C to +40°C, for example, you need not enter +1000°C
for the High and -200°C for the Low because no one would
see the trend curve.

Normally, only people who know that their value is within a
certain range use the Scale fields. For example, say you have
a special Temp sensor in a production process. Its range is
always between 20°C and 25°C but it is very important to
see small changes. For this sensor, you would choose
settings of Low=20 and High=25.

. The Defaults button resets the High/Low settings to the
tag’s default.

If you select the Autoscale checkbox, the minimum and

maximum values of the sensor will be determined automatically

within the current time range. The Scale High and Low fields are

ignored in this case.

If you select the Always show y-axis checkbox, the y-axis for the
current sensor (meaning the sensor whose y-axis properties you
are viewing) will be shown on the grid always, even when another
sensor is selected. Normally, when you select a sensor in the
Legend section, the y-Axis is refreshed and the scale of the
selected sensor is shown. However, if you select the Always show
y-axis checkbox, you will see the current sensor’s y-axis and the
y-axis for the sensor you select in the Legend.

Use the Major Grid to show horizontal lines. The number gives
the number of lines spread over the value range of the sensor
and the values between the lines. To know how many units will be
displayed between two major grid lines, enter a number and
press the Tab or Enter key. The line below shows You will use
XX units per gridline, where xx is the number of units. The xx
value depends on the Scale and the number of gridlines used. For
example, if you turn on the major grid for a Temperature sensor,
you might see You will use 6 units per gridline, meaning
one gridline might show 20°C, while the line above it shows 26°C
and the line below it shows 14°C.

The Band High (26)/Low (26) is the percentage of available space
for this y-axis and the trend curve. The default is O to 100%
(meaning that the grid will use all available space). Band is
helpful for Trends that contain many similar tags (e.g. Battery
voltages=BYV). You can say: Use the lower 50% for BV 1 and the
upper 50% for BV 2. The axis and the trend curves would not
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overlap, but be drawn in different parts of the grid. The settings
for BV 1 would be Low=0, High=50 and the lower half of the grid
would display these voltages. BV 2 would have settings of
Low=50, High=100 and the upper half of the grid would display
its voltages.

Following is an explanation of the options on the Plot tab shown in

Figure 36. Trend Properties, Plot Tab
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- The Visible checkbox has the same function as the checkbox in
the Legend. If the checkbox is selected, the sensor values appear
in the grid. If the checkbox is not selected, the values do not
appear.

- You can use a Line or Bar Style for the values in the grid. The Bar
style is useful for sum values, such as precipitation or data flow.

. Use the Color chooser to change the color of the Line or Bar.
. Select the Line or Bar thickness from the Weight list.

You can define multiple thresholds per tag in a trend. A threshold is an
interesting value (range), where the trend curve “enters” or “leaves” a
certain range. For example, you can set a threshold for when a value
is suddenly outside its usual range (e.g. “only values between 0 and
10°C are valid”) or when a certain value is met (e.g. “when value
drops below 0°C”). illustrates the Thresholds tab.

Do not confuse this feature with the threshold settings in the tag itself.

With addVANTAGE Pro 6.1, each tag, independent from the trend, can
have thresholds. When the tag’s thresholds are met, normally an
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action is performed. The trend’s thresholds are only informational and
thus are not the same as the tag’s thresholds.

Figure 37. Trend Properties, Thresholds Tab
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Following is an explanation of the options on the Thresholds tab shown

in

In the Thresholds list, use the Add, Remove, Move Up, and Move
Down buttons the same way you use them for Tags. In this case,
however, when you Add a threshold, you will give it a name that
has meaning for you.

General

Name the threshold you added. If you don’t enter a name,
addVANTAGE names it something like Threshold 1.

Enter a Value that determines where the threshold starts.

Use the Label Color chooser to pick the color of the name or
value of the threshold displayed in the trend.

Select the Show name on y-axis checkbox to display the
Name of the threshold on the grid, in the color you chose. If
you do not select this checkbox, the Value will be displayed
instead.

When you select the Always show thresholds checkbox, the
threshold always displays on the grid, no matter which
sensor is selected in the Legend. When this checkbox is not
selected, the threshold displays on the grid only when the
corresponding tag is selected in the Legend.

Use the Fill fields to determine an area that should be filled (Fill
to) from the entered Value to a Base set in the next field. You can
also select Min. Scale or Max. Scale to draw a fill box in the range
between the Value and the bottom or top of the plot.

Use the Line fields to determine whether to Paint (draw) a line
and which color to use, as well as which line Weight (thickness)
to use.
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Following is an explanation of the options on the Display tab shown in
. These options apply to the Trend itself, not the individual
tag selected in the Tags list.

Figure 38. Trend Properties, Display Tab
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. If you select the Major Grid checkbox, vertical lines will
display on the grid. The number of lines is not selectable, but
it depends on the selected time range (e.g. 7 lines when 1
Week is selected or one line every 4 hours when 1 Day is
selected). Use the color chooser next to the checkbox to
specify the vertical line color.

. The Time axis color shows the color of the time axis.

- The Duration Options are the same as the duration shown in the
toolbar. You can change the duration on this tab or in the toolbar.

- Use the Graphic Background Color chooser to pick a color for the
grid’s background.

- Use the Axis background color chooser to pick the color that
displays in the background of the Y and X axes.

- Use the Legend background color chooser to pick the color used
for the background of the legend along the left side of the dialog.

- The Show seconds in panels checkbox works as described on

to determine whether seconds show in displays of time.

- Use the Show Legend checkbox to display the Legend next to the
grid.

. Use the Show Values at Cursor checkbox the same way you use
Button 13 in the toolbar. That is, if you select the checkbox and
then click the left mouse button, you see the sensor values at
that position. Furthermore, you can click and drag the mouse to
see all the values.
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If the checkbox is not selected, you see certain statistics on the
fly. Click and drag the mouse between two vertical lines to see a
table with SUM/AVG/MIN/MAX values for all the tags at the
bottom of the grid.

Displaying tags from different areas/RTUs on the same Trend viewer
can be very useful. For example, you could set up a panel showing the
battery level for a group of RTUs and be able to inspect or compare
them at a glance, such as the example shown in

Figure 39. A Trend Viewer Showing Tags from Several RTUs
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You can export all of the data from this graphical view the same way
as from the table view, which is described on

Now that you’ve configured those tags, you might want to save this
panel for later use. If you are working with a data provider rather than
your own copy of addVANTAGE Pro 6.1, please make sure that you
have the privileges to save your changes.

When you first create a trend or any other type of panel, you must
click Save or Save As in the toolbar to save the panel. You typically use
Save As when you’ve made changes to an existing panel and want to
save it under a different name. In either case, the Save dialog shown
in is displayed.

If you try to close an existing Trend, one of two things happens. If you
chose to automatically save panels when you close them (| ),
the Trend closes with any changes you made saved. If you did not
choose to automatically save panels, a pop-up appears, asking if you
want to save the Trend viewer. Click Yes to display the Save dialog.
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Select an area (a folder) where you want your custom Trend viewer
saved. It's best to select an area having a certain relationship with the
content of the Trend, but there is no rule to prevent you from saving it
directly under the root node (except that the name must be unique in
that area). Enter an appropriate name in the Name field, then click OK
to save the customized Trend viewer as a panel.

Figure 40. Save Dialog
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You can also save a panel any time by clicking Save.

If you have to create a large number of identical panels on different
areas, you can use the Trend from template function and save yourself

some work:

1. Create a panel in a single area by using one of the methods
previously described, then add the tags you need and configure
the panel’s properties.

2. Save the panel in its area. This will be used later as a template
panel.

3. Right-click the areas where you want the have the copied Trends
and select Create New Node » Window » Trend from Template. A
File Open dialog is displayed.

4. Navigate to the area where you saved the template panel and

select it, then click OK.

The system creates a Trend panel with the same properties as the
panel used as the template in each area you selected. If a tag does
not exist in the respective area, it won’t be included in the panel. The
new panels will borrow the name of the original panel used as the
template. If a panel with this name already exists in an area, the
newly created panel will have a running number appended, for
example, Weather (2).
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Note: The term “template” is used only for better understanding the concept
of creating panels from existing panels. Any panel can be used as a
template.

To switch from a graphical view to a tabular view of data, click the
Table view button previously described ( ig], ).

While the legend to the left and the tool bar remain the same, your
trend lines will disappear and every value of the time span you
selected will appear as a table, as shown in . Please note that
this usually requires several screens, since a single day of 15-minute
data already consists of 96 entries. You can therefore navigate back
and forth in time by either clicking the page number or the navigation
arrows on the bottom left of the table viewer.

Figure 41. Table View
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You can click the Graphical view button (}--]) to return to the
graphical display.

You can now edit data in the table view. One way to do this is to
double-click a value in the table, type what you want the value to be,
and press Enter. The value displays in the table and the cell is
highlighted in red. If you change your mind, you can right-click in the
cell and select Remove manual values.
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If you want to add values to the table, right-click in the table and
select Add new values to display the dialog shown in

Figure 42. Adding a Value in the Table View
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Say you manually recorded values in addition to the u’s values. You
can add them to the table by following these steps:

1.

Select the tag (that is, the Tag) from the dropdown.
If you right-clicked a column in the table view, that tag is
displayed by default.

Select the date and time (Timestamp) for the first new value.
The Duration defaults to the recording interval for the selected
tag’s values. Change this duration if needed.

Enter the Value and click Add.

The dialog remains, but the timestamp moves to the interval
shown in the Duration field.

Enter any other new values, clicking Add each time.

When you’ve entered all the values, click Close.

The table will redisplay with the manual values you’ve just
entered highlighted in red.

If you entered values that already existed for the timestamp you
selected, they will overwrite the table’s values as manual entries.

While viewing data in the table view you can easily export all or part of
it into an ASCII format file. In the graphical view, you can export only
all of the data.

N

Right-click in the body of the table.

Choose Export from the menu that appears.

Depending on your browser, you can open and/or save the file on
your computer. The default name of this file is value . txt, which
you should replace with a more meaningful name.
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4. You can now open this file with any text editor or software such
as Excel or O0o0.Calc

Figure 43. Export All Data from Table View

Date | . Battery Voltage | . Battery Voltage | Battery Voltage | Battery Voltage
Jan 23, 2011 11:36 PM QA1
Jan 23, 2011 11:40 PM 7.4 V Copy selected values to clipboard
Jan 23, 2011 11:45 PM Export all values in selected time range. .. 6,90 W
Jan 23, 2011 11:50 PM 7.14 V T}
Jan 23, 2011 11:51 PM Add new values

Remnove manual values

[ sanual Event...

= Properties...

<231 231232 233

The values exported are not limited to the values you can currently
see on the screen. This tool will export all the data that you could see
in the initial table view, with the start date as shown in the calendar,
and the amount of data as shown in the Span area (List 12 on page

). Look at the example above. What we export in is the
data as can be seen in : 1 week (calendar), beginning on
January 17.

Should you want to export all the data of a selected trend, you need
to:

- Set the start date to the beginning of the database (Button 5 - Go
to Begin)

- Select Custom in the Span Chooser (List 12), then select a
reasonable duration that shows all of the data on the Display tab.

If you want to export only a few lines of data from the current screen,
you can copy them to the clipboard.

1. Select data you want to copy (Ctrl+Click or Shift+Click, as shown
in .

2. Right-click in the body of the table and select Copy to clipboard
from the menu that appears.
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3. Open a text editor or spreadsheet program such as Excel or
0O0o0.Calc and paste the contents of the clipboard.

Figure 44. Copying Selected Data into the Clipboard
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If you click the Virtual Instruments button (|:f]), you can view trend
data in one other view ( ). similar to what you might see on
an instrument panel.

Figure 45. Trend Viewer Using Virtual Instruments
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Use the Events viewer to see the events generated by nodes. To
create an Events viewer, click New Window and select Events Viewer.

You’ll notice that the toolbar is very similar to the Trend’s toolbar. You
are not able to print the Events viewer, but you can click | L to export
the table values to a PDF file. The other buttons up through the time
span chooser are identical. The differences after the span chooser are
that the Events viewer has an Acknowledge button, and no button for
switching between views (only the tabular view is available).

The Events viewer has extensive configuration possibilities to help you
display the events and alarms in the most appropriate way for your



CHAPTER 4

The Events Viewer

needs. In an active Events viewer, click Properties to display the
Events Options dialog shown in

Use the Nodes tab ( ) to select the nodes whose events you
want to display. It is the second tab in the Properties dialog, but you
must select a node before you can select the event types to display

alarms for. With addVANTAGE Pro 6.1, all nodes can issue events.

Figure 46. Events Options Dialog, Nodes Tab
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- Click the Add button to display the Nodes Chooser ( ),
which you use to add nodes whose events you want to view. You
can select the root or expand it to select areas.

Figure 47. The Nodes Chooser
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. To remove a node from the Events viewer, select it on the Nodes
tab and click the Delete button.

- Use the Also show events from child nodes checkbox to see
alarms/events from nodes belonging to the node you selected.

Another way to create an Events viewer is to select the nodes whose
events you want to see from the Explorer, then right-click and select
Show Events. Click Properties in the viewer to see the dialogs
discussed here.
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The Event Types tab ( ) displays all of the types of events that
can issue an alarm or event. If the tab is blank, you have not selected
any nodes (see

You can drill down in the list to see that all events are selected by
default. If you do not want a specific event to display in the Events
viewer, unselect it in the list.

Figure 48. Events Options Dialog, Event Types Tab
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The Event Types tab has several options for viewing events.

First, you can select which types of events to view in the Severity
section:

- Show alarms displays alarms.
- Show events displays events.

- Show service logs displays messages from the system or from
administrators, such as when an RTU has been replaced.

You can also use the Event filter section to further customize the Event
Viewer. For example:

. Show only active displays only active alarms/events, depending
on your choices for the next two checkboxes. If you leave this
checkbox unselected, all alarms/events for the selected span will
be displayed in the Events viewer. “Active” is defined as an alarm/
event whose end date has not been reached or is unknown.
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- Only not acknowledged events allows you to display only those
messages you have not set as acknowledged.

A new alarm that can be set in an Events viewer is the alarm on
delayed data.

The Events Options tab ( ) has customization options for the
data to be displayed in the viewer.

Figure 49. Events Options Dialog, Events Options Tab
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- In the Columns section, each checkbox represents a column.

Select the columns you want to see in the viewer

- The Duration Options mirror the settings on the toolbar. You can
choose to Always jump to last available data or not. If you do
select the checkbox, you will either view All of the available data
or a Custom amount—data from the last available to a time frame
you specify in Duration. As an example, say the tag was installed
on January 1, 2009. If you choose All, the Events Viewer will
display the most recent data—perhaps today’s data (the “last
available”)—back to January 1, 2009. However, if you select
Custom and then 26 Week(s), you’'ll see the most recent data and
back only 6 months from the most recent date.
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Click OK when you are finished. The Events viewer (Figure 50) shows
the events you selected.

Figure 50. Events Viewer Showing Events
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Note: If no events are displayed, check the date and use the arrows and the

calendar to move to a date and time where you have data.

Event Alarms

By default, alarms are shown in red. If you click the Acknowledge
checkbox or button, they turn blue, which means that the alarms have
been acknowledged.

If an extension issued an alarm, an alarm icon will be shown in the
Explorer window by that extension (Figure 51), and the alarm icon will
also be shown next to all the parent areas (folders) where the
extension resides. Therefore, while it’s the Statistic extension that
has an alarm, the Hop crop and the Dimi area folder also show the
alarm icon.

Figure 51. Alarm lcons in the Explorer
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Locating the Source of an Alarm

If you notice in an Explorer that an area shows an alarm, you can
right-click the node and select Show Events. An Events viewer
properly configured for you is displayed, showing only the alarms
pertinent to the selected object.
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Right-click in an Events viewer to see the context menu shown in

Figure 52. Event Viewer Context Menu

# Manual Event. ..
Irrigation
@ Treatments
S Export all walues in time range to POF

= Properties...

Use this menu when you need to manually add an event or show
irrigation or treatments.

You can save your Events viewer as a panel, just like you did with the
Trend (see also page 52). You can also export events in the table view
to a PDF file by right-clicking anywhere in the table and selecting
Export all values in time range to PDF (see ).

The dialog shown in appears.

Figure 53. View/Save Window for Event List PDF
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Notice that the file is named report.pdf by default. You can view
the document immediately by selecting Open with, or you can use
Save to Disk to save the file to the default location for your
downloaded files. If you open the PDF, then save it, it is by default
saved in your Temp folder.

When you view the PDF, you’ll see that all of the events that are
shown in the panel are included.
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If you have to create a large number of identical panels on different
areas, you can use the Events from template function and thus save
yourself some work:

1. Create a panel in a single area using one of the methods
described above, then add the events you need and configure the
panel’s properties.

2. Save the panel in its area. This will be used later as a template
panel.

3. Right-click the selected areas where you want a copy of the
Events viewer and choose Create New Node » Window » Events
from Template. A File Open dialog displays.

4. Navigate to the area where you saved the template panel and
select it, then click OK.

The system creates an Events panel with the same properties as the
panel used as the template in each area you selected. If an event
source node does not exist in the respective area, it won’t be included
in the panel. The new panels will borrow the name of the original
panel used as the template. If a panel with this name already exists in
an area, the newly created panel will have a running number
appended, for example, Statistics (2).

The term “template” is used only for better understanding the concept
of creating panels from existing panels. Any panel can be a template.

You can link two panels by combining them in a single window. You
can then use the standard navigation methods to “move” both panels
synchronously in time.

Only Trend and Events panels can be linked.

To combine two panels, click the Link to another window button (2z])
on the toolbar of one of the panels. In the Explorer that is displayed,
navigate to and select the panel you want to link, then click OK. A new
panel will be created. You can now save the linked panel for future
use, just like any other panel ( ).

The original panels are not affected.
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Figure 54. Linked Panels
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0.0
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0.0
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Ej Light infection index
0.0
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402510 4026110 426110 428010 430710
2 | Begin Date = Duration ¢ Source ¢ Area s | Cornments ¢ I
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To change the properties of an individual panel, right-click the
appropriate panel and select Properties.



As with previous versions, the addVANTAGE Pro 6.1 software has
extended functionality through additional software modules called
extensions.

However, instead of a main extension, you work with crops, calculation
extensions, and disease models. Crops might seem to be the plant
protection extensions you’ve worked with before, but they are actually
nodes that store information about phenophases, irrigations, and
treatments. They are not extensions. Disease models and calculation
extensions are relatively new to addVANTAGE Pro. Disease models are
extensions that apply only to crops. They “hear” events issued by the
crop. Calculation extensions usually apply to an area. Although they
can be children of a crop node, calculation extensions do not “hear”
events issued by the crop (such as when a treatment is applied).

Some extensions are included with the software and others can be
installed separately. For example, Adcon Telemetry provides a
collection of calculation extensions and disease models (still
collectively known as extensions) in a package you can receive free of
charge upon request from your Adcon distributor. These extensions
are documented in a separate addVANTAGE Pro 6.x Extensions and
Crops manual. This manual is located on the software CD, which also
contains these free extensions, or you can download it from Adcon
Telemetry’s website at http://www.adcon.at.
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You will also find that certain calculation extensions and disease
models have additional information available in the software itself, on
their Properties dialog’s Extension tab. When you see an “info” button
like the one shown in , click it to open a dialog with
additional information about using the extension.

Figure 55. Info Button for Apply Powdery Mildew (Kast OiDiag)
Extension

General | Bxtension | Inputs | Action | Security |

Algorithm variables

INFO

Lrop: Sensitive ~ / BUTTON

Used method to start the index calculation: @

@ Phenological stage

Last year savarity

Ok Cancel Apphy |

An extension will automatically recalculate some properties in the
input data sets if their options have been changed. This operation
usually takes only a couple of seconds, but in extreme cases (large
data sets or many extensions running in parallel) it can take up to
several minutes. The properties in the Crops, Treatments, Inputs,
Irrigation and Extension tabs may force a recalculation if changed.
You can also force a recalculation of one or more extensions by
selecting the respective extension in the Explorer, right-clicking, and
selecting Recalculate.

Extensions can be added to areas and crops, while crops can be added
only to areas. To add either, follow these steps:

1. Open an Explorer.

2. Select where you want the extension or crop added (use the shift
and control keys if you're selecting multiple locations).

3. Right-click the highlighted areas and select Create New Node »
Calculation extension » extension or Create New Node »
Crops » crop.

The extension or crop is added to the area in the Explorer, where you
can configure it as needed. When you add a crop, all of the disease
models of the crop are created by default.
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You can add multiple extensions and crops to the same area and
create different settings for each. Subsequent extensions and crops in
the same area take the name of the first, but with a number appended
(for example, Apple [1] or Running Total [1]).

You can also edit multiple extensions and crops. Use Ctrl-Click to
select the nodes, then click Properties. If the selected extensions are
not identical, only their common properties will be displayed.

Finally, you can add an extension or crop by creating it from a
template, that is, from an existing extension or crop.

1. Add the extension or crop in a single area using one of the
methods described above and set up its properties as you want
to.

2. Right-click the selected areas where you want a copy of the
extension or crop and select Create New Node » Calculation
extension » Create from template or Create New Node » Crops »
Create from template. A File Open dialog displays.

3. Navigate to the area where you saved the template panel and
select it, then click OK.

The system creates the extension or crop with the same properties as
the one used as the template in each area you selected. All child
extensions will also be created.
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Some extensions and crops must be configured. To display the
properties ( ), highlight the extension or crop in the Explorer
and click the Properties icon.

Figure 56. Statistics Extension Properties Dialog, General Tab

General | Extension | Inputs | Action | Secur‘it\,rl

| Stafistc
Location: faddVANTAGE Pra afDimif Statistic
Class: EXTENSION
Subclass: statistic
Node ID: 1682
Alarmns; 1 total, 0 acknowledged.
Events: 0 total, O acknowledged.
Service logs: 0 total, 0 acknowlzdged.
Last calculation performed at: -
Time zone: Europe/vienna

@ Enabled

Dizabled
Ok Cancel Apphy |

shows the properties specific to the Statistics calculation
extension.

The General tab displays general information about the extension/
crop, and for calculation extensions and disease models, allows you to
enable or disable individual extensions. If you look closely at the
extension’s icon, you can tell whether the extension is enabled or
disabled.

The green triangle The gray square

in the bottom left in the bottom left
corner indicates S corner indicates  gj
the extension is the extension is
enabled. disabled.

If an extension is being executed, the green triangle appears to move
across the bottom of the icon.

The Action and Security tabs are discussed in Chapter 3, beginning on



Note:

Three additional tabs pertain to crops.

Use the Crop tab (

stages of crops.
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) to specify and monitor the phenological

Figure 57. Apple Crop Properties, Crop Tab

General | Crop | Treatments | Irrigation | Action | Security |

BBCH

Marmea

Data

Q0 Dormant Jan 1, 2011

07 Bud Break bar 12, 2011
0% Green tp Mar 19, 2011
55  First flower buds visible Apr 26, 2011
57 Pink Bud Mey B, 2011
65 Bloom beny 21, 2071
g2 Postbloom Jun 5. 2011

72 Fruit Size up to 20 mm Jun 30, 2011
87 Fruit Ripe for Picking Aug 29,2011

Ok | Cancal | Apply |

Clicking a phase causes a graphic depiction of the phase to be
displayed on the right side of the dialog, if such a graphic is available.

Changing Dates for Phenological Phases

In principle, the system can be installed anytime, but starting it at the
beginning of the growing season has certain advantages. The software
uses a calendar year with the appropriate phase dates set, but you

can change these dates. Do this by using the Crops panel, which sets
the proper phenological phase.

To set the season or phase starting date, complete the following steps

( ):

Right-click the crop and select Properties.

1
2. Click the Crop tab.
3. Select the desired phase in the Name column.
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4. Click the calendar icon and select the date for the phase to begin,
then click Apply.

Figure 58. Setting a Phase’s Start Date

General | Crop | Treatments | Irrigation | Action | Sewrit;rl

secH | Name | Date |

00 Darmant Jan 1, 2001

a7 Fud Break Mar1?, 2011
0% Green tip Mar14, 2011
55  First flower buds wisibla Apr 26, 2011
57  Pink Bud ey 6, 2011
65 Bloom Mary 21, 2011
69 Post bloom Jun B 2011

72 Fruit Size up to 20 mm Jun 30, 2011
387 Fruit Ripe for Picking Aug 29,2011

QK Caneel | Apply J

Generally, the first phenological phase corresponds with the year’s
begin in the northern hemisphere, that is the 1st of January. After you
set the date for a phase, dates for subsequent phases are
automatically computed from the defaults programmed for each crop.

Climatic conditions during certain seasons could differ from the pre-
programmed defaults, so Adcon recommends that you verify at
regular intervals whether the model is in synchronicity with the field
conditions. If this is not the case, use the method described above to
change each individual phase’s date accordingly.

Use the Treatments tab ( ) to inform the crop that a chemical
treatment was applied.

If the chemical you want to apply is not in the system’s database, you
must first add it. For more details about adding to or modifying the
chemicals database, refer to the addVANTAGE Pro 6.x Extensions and
Crops manual.

Figure 59. Apple Crop Properties, Treatments Tab
General | Crop | Treatments | Irmigation | Action | Security |

Application date « | Chemical = | Remark |
Mar 26, 2010 5:04:00 Systemic - SCAB

OK Cancel Apply |




Note:

Note:
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Adding Treatments

A spraying application usually follows a treatment recommendation
(displayed in the Events list). To inform the model you applied a field
treatment, do the following ( ):

1. Right-click the crop and select Properties.
2. Click the Treatments tab, then the Add icon.

Figure 60. Applying a treatment

Chemical: Warning ignored (Cougar blight) -
APplEIton 112y 17. 2010 945 PM Europe/Vienna
Remark:

OK | Cancel |

3. Select the chemical you applied in the field from the list.

4. In the Application date field, click the calendar icon to select the
correct treatment date and time from the pop-up that appears.

The wording shown to the right of the calendar icon indicates the
server’s location.

5. Enter a Remark. (optional)
6. Press OK when you are done.

If you want to add a spray for more than one disease (even if the
chemicals used are identical), you have to perform this operation for
each individual disease for which the treatment is valid.

If you decide that you don’t need to apply a treatment, e.g. if other
circumstances determine a treatment is not warranted, you must
select the entry “Warning ignored” from the chemicals list. Whatever
the case is, you must either apply a treatment or choose to ignore the
warning. Failure to do so will leave the current alarm active and no
new warnings will be issued.

Removing a Treatment

If you added a treatment and you find out at a later date that it was
incorrect (either the date of application, or the type of chemical), you
can delete the treatment and add the correct one, if needed. Proceed
as follows:

1. Right-click the crop and select Properties.

2. Click the Treatments tab.

3. Select the treatment from the lower list and click the Remove
icon.

4. Click the OK button.
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The system automatically recalculates the model’s new data.

Use the Irrigation tab ( ) to create irrigation schedules for the
crop.

Figure 61. Apple Crop Properties, Irrigation Tab

General | Crop | Treatments | Irrigation | Action | Security |

Application date = |Duration sjQuantity <| Remark
Mar 1, 2010 4:00:00 AM 1zh 3.0 mm initizl irrigation
OK | Cancel | Apply

Adding an Irrigation Schedule

When you add an irrigation schedule, you are telling the model what
type of irrigation, how long the irrigation occurs, and how much
irrigation the crop gets ( ). Follow these steps to add this
schedule:

1. Right-click the crop and select Properties.
2. Click the Irrigation tab, then the Add icon.

Figure 62. Adding Irrigation

Irnigation Type Sprinkler -
Application date: Mar 17, 2010 343 PM Europe/f\Vienna
Duration: 1d h m
Quantity: 0 mm
Remark:

OK | Cancel |

3. Select the Irrigation Type.

4. In the Application date field, click the calendar icon to select the
correct treatment date and time from the pop-up that appears.

Note: The wording shown to the right of the calendar icon indicates the
server’s location.
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5. In the Duration field, enter how long the irrigation lasted, in days,
hours, and/or minutes.

6. In the Quantity field, enter how much water was sent to the crop.
7. Enter a Remark. (optional)
8. Press OK when you are done.

Removing an Irrigation Schedule

If you added an irrigation and you find out at a later date that it was
incorrect, you can delete the treatment and add the correct one, if
needed. Proceed as follows:

1. Right-click the crop and select Properties.
2. Click the Irrigation tab.

3. Select the appropriate irrigation schedule from the lower list and
click the Remove icon.

4. Click the OK button.

Calculation extensions and disease models have tabs that are different
from the ones for crops.

Most calculation extensions have an Extension tab, as shown in

Figure 63. Statistic Extension Properties, Extension Tab

General | Extension | Advanced settings | Inputs: | Action | Security |

Schedule

Begin date: Time zone; CET
End date: Tima zone: CET
Begin time: 33|Z|: 53|Z|

Scheduling

Calculate one value per l@ Day(s) -
Use values of the last 1[2] oavis) =

Computations

Mimimum
i

[iin + Max) /2
Average

SU

Circular average

0K Cancel Apply
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The Extension tab contains options and configuration panels that are
specific to the extension.

The Advanced settings tab ( ) provides additional information
about the extension options.

Figure 64. Statistic Extension Properties, Advanced Settings Tab

General | Extension | Advanced settings | Inputs | Action | Security |

Name | Type | Value I Unit
AVG Boolean false
MAK Boolean false
MID Boolean false
MIN Boolean false
SUM Boolean false
CAVG Boolean false

Resetto default |

OK | Cancel | Apply |

Note that your ability to see the Advanced Settings tab is determined
by your user role and a setting in the Tools menu.

The Inputs tab ( ) allows you to set the input tags for the
extension. The extensions have an intelligent algorithm that searches
for the appropriate tags, but only within the extension’s own area.

Figure 65. Extension Properties Dialog, Inputs Tab

General | Extension | Advanced settings | Inputs. | Action | Security |

a Generic Input

oK | Cancel | Apply |

Adding Inputs

If some tags are missing and the auto discovery feature fails, you
should manually intervene to identify the required tags. If multiple
tags of the same type exist on a given area, you will have to manually
select which tag type you want. You can also choose tags from other
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areas if you need the same type of tag in more than one area, or if the
application can be used with tags from other areas.

For more details about calculation extensions and disease models,
please consult the addVANTAGE Pro 6.x Extensions and Crops manual.



This appendix contains information concerning third-party tools Adcon
employs.

The following tools are used in the addVANTAGE Project. You can find
the actual license agreement for each tool in our separate document,
addVANTAGE Pro 6.1 Third-Party License Agreements.

acme.jar
http://www.acme.com/java/software/
Freeware, license inside sourcecode
Used to en-/decrypt the license file

ant.jar

Version 1.6.2

http://ant.apache.org

Apache License Version 2.0, January 2004

Used to compile the project with dependencies on other project parts

antlr-2.7.6.jar

Version 2.7.6, Current Version 3.2
http://www.antlr.org/

Freeware

Database framework
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backport-util-concurrent-3.0.jar

Version 3.0, Current Version 3.1
http://backport-jsr166.sourceforge.net/
Creative Common Public Domain
Database framework

beprov-jdk14-131.jar

Version 1.31, Current Version 1.37
http://www.bouncycastle.org/
MIT License
keymanager.RSACipher

commons-beanutils.jar

Version 1.6, Current Version 1.7
http://jakarta.apache.org/commons/beanutils/
The Apache Software License, Version 1.1
Toolkit which is used for webdevelopment

commons-codec-1.3.jar

Version 1.3, Current Version 1.3
http://jakarta.apache.org/commons/codec/
Apache License Version 2.0, January 2004
Used to en-/decode binary data

commons-collections-3.1.jar

Version 3.1, Current Version 3.2
http://jakarta.apache.org/commons/collections/
Apache License Version 2.0, January 2004
Helper for webapplication

commons-digester.jar

Version 1.5, Current Version 1.7
http://jakarta.apache.org/commons/digester/
The Apache Software License, Version 1.1
Toolkit which is used for webdevelopment

commons-discovery-0.4.jar

Version 0.4, Current Version 0.4
http://commons.apache.org/discovery/
Apache License Version 2.0, January 2004
Webapp programming framework

commons-logging.jar

Version 1.0.4, Current Version 1.1
http://jakarta.apache.org/commons/logging/
Apache License Version 2.0, January 2004
Helper for Scheduler (Quartz)
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commons-logging-api.jar

Version 1.0.4, Current Version 1.1
http://jakarta.apache.org/commons/logging/
Apache License Version 2.0, January 2004
Helper for Scheduler (Quartz)

commons-validator.jar

Version 1.1.3, Current Version 1.3.1
http://jakarta.apache.org/commons/validator/
Apache License Version 2.0, January 2004
Used to validate entries in webapplication

datetimepicker2.7.jar

Version 2.7, Current Version 2.7
http://www.lavantech.com/datetimepicker/
Bought - http://www.lavantech.com/license.shtml
Used to set addMIN’s update Backup time

dom4j-1.6.1.jar

Version 1.6.1, Current Version 1.6.1
http://www.dom4j.org/

BSD license

For all parts that are by SPG

ehcache-1.5.0.jar

Version 1.5.0, Current Version 1.7.2
http://ehcache.org/

Apache License Version 2.0, January 2004
Database framework

ejb3-persistence.jar
Version 3.0 FR (1.0.1.GA)
basically MIT

Database framework

gmaps4jsf-1.1.3-u3.jar

Version 1.1.3
http://code.google.com/p/gmaps4jsf/
Apache License Version 2.0, January 2004
Support in Google Maps API access

h2-1.1.118.jar

Version 1.1.118, Current Version 1.2.126
http://www.h2database.com/html/main.html
Mozilla PubLic 1.1, Eclipse PubLic 1.0
In-memory Database
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hibernate-annotations.jar

Version 3.4.0.GA, Current Version 3.4.0.GA
http://annotations.hibernate.org

LGPL

Database framework

hibernate-commons-annotations.jar
Version 3.1.0.GA
http://annotations.hibernate.org
LGPL

Database framework

hibernate-core.jar

Version 3.3.0.SP1, Current Version 3.3.2.GA
https://www.hibernate.org/344.html

LGPL

Database framework

hibernate-entitymanager.jar

Version 3.4.0.GA, Current Version 3.4.0 GA
https://www.hibernate.org/397.html

LGPL

Database framework

iText-2.0.7.jar

Version 2.0.7, Current Version 5.0.0
http://itextpdf.com/

LGPL (Version 2.1, February 1999)
PDF creation

jaas.jar
http://java.sun.com/javase/technologies/security/
Sun binary code license (—Freeware)

Used in authentification

JainSipApil.2.jar

Version 1.2
http://jain-sip.dev.java.net/
Public Domain, SIP Calls

JainSipRil.2.jar

Version 1.2
http://jain-sip.dev.java.net/
Public Domain, SIP Calls

javassist-3.4.GA.jar

Version 3.4.GA, Current Version 3.11.0.GA
http://www.csg.is.titech.ac.jp/~chiba/javassist/
LGPL

Database framework
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jaxen-1.1.1.jar

Version 1.1.1, Current Version 1.1.1
http://jaxen.org/

Apache style, Attached

Xpath in DOM4J (webapp)

JbcParser.jar

Version 3.7, Current Version 3.7
http://www.bestcode.com/html/jbcparser.html
Bought

Basic arithmetic extension parser

jcommon-1.0.10.jar

Version 1.0.10, Current Version 1.0.10
http://www.jfree.org/jfreechart/

LGPL (Version 3, June 2007)

Chart drawing tool

jfreechart-1.1.1_adcon.jar

Version 1.1_adcon, Current Version 1.0.6
http://www.jfree.org/jfreechart/

LGPL (Version 3, June 2007)

Chart drawing tool

jmf.jar

http://java.sun.com/products/java-media/jmf/

JMF License

Java Media Framework, used to play Wave files in SIP calls

jsf-api-1.2_04-p02.jar

Version 1.2_04-b16-p02, Current Version 2.0
http://java.sun.com/javaee/javaserverfaces/reference/api/
CDDL (parts Apache)

Webapp programming framework

jsf-facelets.jar

Version 1.1.14
https://facelets.dev.java.net/

Apache License Version 2.0, January 2004
Webapp programming framework

jspeex.jar

Version 0.9.7
http://jspeex.sourceforge.net/index.php
BSD License

Used in SIP Calls
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jstl.jar

Version 1.1.2
http://tomcat.apache.org/taglibs/standard/
Apache License Version 2.0, January 2004
JSP Standard Tag Library

jta-1.1.jar

1.1

1.1
http://java.sun.com/javaee/technologies/jta/index.jsp
Attached

Database framework

log4j-1.2.14. jar

Version 1.2.14, Current Version 1.2.14
http://logging.apache.org/log4j/docs

The Apache Software License, Version 1.1

Used to create logfiles depending on the loglevel and package name

mail.jar

Version 1.2, Current Version 1.4
http://java.sun.com/products/javamail/
Click Download / you must accept License
Used to handle E-Mail

minimalSipCaller.jar

Derived from http://sip-communicator.org
LGPL (Version 2.1, February 1999)

Used in SIP Calls

myfaces-api-1.2.3.jar

Version 1.2.3, Current Version 2.0.0-alpha
http://myfaces.apache.org/

Apache License Version 2.0, January 2004
Webapp programming framework

myfaces-impl-1.2.3.jar

Version 1.2.3, Current Version 2.0.0-alpha
http://myfaces.apache.org/

Apache License Version 2.0, January 2004
Webapp programming framework

nist-sdp-1.0.jar
http://jain-sip.dev.java.net/
Public Domain

Used in SIP Calls
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ojdbc14.jar

Version 10.2.0.1.0, Current Version 10.2.0.1.0
http://www.oracle.com

Bought

Used in the Oracle database connection

quartz.jar

Version 1.6.0, Current Version 1.6.0
http://www.opensymphony.com/quartz/

Apache License Version 2.0, January 2004

Scheduling engine used for addTimer and data acquisition

richfaces-api-3.3.1.GA. jar

Version 3.3.1.GA, Current Version 3.3.2 SR1
http://www.jboss.org/richfaces

LGPL

Webapp programming framework

richfaces-impl-3.3.1.GA.jar

Version 3.3.1.GA, Current Version 3.3.2 SR1
http://www.jboss.org/richfaces

LGPL

Webapp programming framework

richfaces-ui-3.3.1.GA. jar

Version 3.3.1.GA, Current Version 3.3.2 SR1
http://www.jboss.org/richfaces

LGPL

Webapp programming framework

serializer.jar

Version 2.7.0

http://xml.apache.org/xalan-j/

Apache License Version 2.0, January 2004

Helper to (de-)serialize data, which is needed by Velocity

slf4j-api-1.5.3.jar

Version 1.5.3, Current Version 1.5.10
http://www.slf4j.org/

Freeware

Used for logging in JPA

slf4j-log4j12-1.5.3.jar

Version 1.5.3, Current Version 1.5.10
http://www.slf4j.org/

Freeware

Used for logging in JPA
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struts.jar

Version 1.2.4, Current Version 2.0.8
http://struts.apache.org/

Apache License Version 2.0, January 2004
Framework that supports web development

velocity-1.4.jar

Version 1.4, Current Version 1.5
http://velocity.apache.org/

Apache License Version 2.0, January 2004
Framework that supports web development

velocity-tools-1.1.jar

Version 1.1, Current Version 1.3
http://velocity.apache.org/

Apache License Version 2.0, January 2004
Framework that supports web development

Xxalan.jar

Version 2.7.0, Current Version 2.7.1
http://xml.apache.org/xalan-j/

Apache License Version 2.0, January 2004
Used in the database framework

Xxmlsec-1.4.2.jar

Version 1.4.2, Current Version 1.4.3
http://santuario.apache.org/

Apache License Version 2.0, January 2004
Used in the database framework
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remote station,

root node,

RTU,

Sensor,

Sserver,

services,

tab,

tag,

text field,

Trend viewer,

virtual sensor,
deleting

objects from a List,
disconnecting from the server,
disease models

definition, 18,

properties,
displaying

data in a Trend Viewer,

engineering units,

node IDs,
document conventions,
dropdown, definition,
duration, session timeout,

E

editing
account privileges,
password,

personal information,
read/write permissions,
user profile,
e-mail address,
engineering units, displaying,
Events Viewer
choosing nodes,
creating event panel from template,
creating events,



examples of addVANTAGE Pro installations,

default options,
definition,
event types,
exporting data,
linking panels,
opening,
options,
removing areas,
sample,

saving,

showing alarms,

Explorer

crops,
definition,
disease models,
displaying alarms,
extensions,
functions,

panels,

RTU,

tags,

tools menu,

exporting

ASCII data from trend,
event data,
selected trend data,

extensions

F

adding multiple,

adding to areas,
automatic recalculation,
common properties,
configuring,

crop stages,

definition,

hiding,

in Explorer,

input tags,

showing alarms in Explorer,
tab on properties dialog,
tools menu,

forcing

properties recalculation,

full name,

G

gateway
data storage,
graphical view of a trend,

imperial measurements,
importing

tag values,
inputs properties,
installing

examples,
instrument view of trend,
Internet services

WAP access,
irrigation properties,
irrigation, adding to events viewer,

L

language, selecting,

linking panels,

List
adding items through search,
adding objects,
definition,
deleting objects,
opening,
quick search,

listbox, definition,

locating the source of alarms,

M

manual event, adding to viewer,
map view,

metric measurements,
modularity of Adcon system,

N

new features,
node IDs, displaying,
nodes

creating,

INDEX



renaming,
selecting to display events,

O
opening
Events Viewer,
List,
Trend Viewer,
options in an Events Viewer,

P
panel, definition,
panels
default options,
reopening last panels,
tools menu,
parameters, definition,
password, needed for WAP access,
phone number,
plant protection properties,
properties
actions,
advanced settings,
calculation extensions,
crop,
disease models,
extensions,
inputs,
irrigation,
permissions,
treatments,
properties of RTUs and tags,
public trend,

Q

quick search for List items,

R

radio button, definition,
remote station, definition,
remote telemetry unit. See RTU.
removing

areas from event viewer,
renaming nodes,
reopening panels when logging in,

root node, definition,
RTU
definition,
in areas,
in Explorer,
properties,

S
saving
Events Viewer as a panel,
Trend Viewer as a panel,
searching for items to add to a List,
security
node,
user options,
selecting
ASCII data sets to export,
language,
nodes to display events for,
options for a Trend Viewer,
sensors, definition,
server
definition,
disconnecting from,
service logs, events,
services
chemicals,
definition,
session timeout,
settings
conditions that trigger events,
default start date for crops,
events and actions,
input tags for extensions,
node permissions,
tag thresholds,
tools menu, 33,
trend thresholds,
showing

advanced settings for extensions,

alarms in Events Viewer,
crops,

extensions,

node IDs,

switching from graphical to trend view,

INDEX



T

tab, definition,
tabular view of trend data,
tags
adding to trends,
definition,
in Explorer,
properties,
setting in extensions,
setting thresholds,
templates
creating events viewer,
creating trend,
extension, crop,
text field, definition,
thresholds
tag,
trend,
tools menu
chemicals,
crops,
engineering units,
explorer,
extensions,
panels,
security,
settings,
using,
treatments
adding to events viewer,
properties,
recommending,
Trend Viewer
adding tags to trends,
creating trend panel from template,
definition,
displaying data,
drag and drop,
Explorer,
exporting data,
instrument view,
linking panels,
opening,
saving a view,
selecting options,

setting thresholds,
trends
default options,
making public,
types of events for Events Viewer,

U

updating the system configuration,
using
imperial measurements,
metric measurements,
template for event panels,
template for trend panels,
tools menu,

V
viewing
data,
events,
RTU on map,
switching from graphical to trend view,
trend data in a graph,
trend data in a table,
trends,
virtual instruments of a trend,
virtual instruments
trend,
view,
virtual sensor, definition,
visibility of crops,

wW

WAP
enabling access,
password needed,
what's new,
window conventions,

INDEX
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